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I designed a christmas card and I normally print it on vista print.


When I ask for a print proof the outlines show. They donâ€™t show when I print it at home.


Why are there unwanted white lines appearing in this PDF print proof and how can I solve this problem?

    


        
            
                
                    
                    	adobe-illustrator
	print-design


                

            

        


    
        
            
                




    

        
            Share
        



                    
                        Improve this question
                    


                
                    
                        Follow
                    
                







    

    



            


                

    
        
            edited Oct 14, 2017 at 8:15
        

        
    

    
        

    

    
        Wrzlprmft♦
        
            14.8k55 gold badges6161 silver badges9393 bronze badges
        

    



                

            
                
    
        
            asked Sep 13, 2014 at 15:26
        

        
    

    
        

    

    
        JessicaJessica
        
            15111 gold badge11 silver badge33 bronze badges
        

    





            

        

    

    






            0 
    
        
            

	    


        
                    Add a comment
                 | 
            
        
         
    

    







                
                
                
                    
                    
                        
                            
                                
                                        9 Answers
                                    9
                                

                            

                            
                                


    
        
            Sorted by:
        
        
            Reset to default
        
    

    
        
                        Highest score (default)
                    

                        Date modified (newest first)
                    

                        Date created (oldest first)
                    


    





                            

                        

                    



                                    


    
        
            
        
            
        
        
            20
        

        
            
        


        

    
    








            
                
                    
                

            


    
    




        


        


    
    
These hairlines are due to flattening, anti-aliasing, and overprinting.

Essentially they show the seams between where transparency has been flattened to preserve appearance. If you zoom in or out you will most likely see the lines disappear or appear in other areas, but will never increase in size.

As a print proof it's most likely that the PDF is in PDF/X-1a format or Acrobat 4-5 format. These are flat file formats and require art not contain transparency for proper rendering. This is very common in printing. These hairlines will absolutely disappear when the PDF is printed using a commercial printing press. (A "digital press" is a actually a copier and not a press, please continue reading.)

These don't show when the art is printed on a printing press. 
This is an on-screen issue only.

There are a few things which may help the on-screen display....

First, never view print proofs in a browser window. Never. The browser plug ins used to view PDFs are not designed to render everything absolutely accurately. They are designed to show the PDF as best as possible so it can be seen - generally there's no attention to more advanced PDFs containing print production items such as spot colors, overprints, etc.. Always download/save the PDF and.....

Second, use an Adobe product to view PDFs. Most other PDF viewers have display issues once you start getting into more complex PDFs than what Office spits out. Using Adobe Acrobat or Reader will help.

Third, set the preferences in Reader or Acrobat to Always use overprint preview. In addition, ticking "enhance small lines" and "smooth images" may also help (same screen as below).



The above items may remove the hairline appearance entirely for proofing press PDFs.

If your'e generating PDFs and this is an issue.....

Fourth, you can save/export the PDF to a PDF format which is not a flat file format. Essentially anything as Acrobat 6 (PDF1.5) or higher. These more recent PDF formats support transparency and will not flatten the file, thus won't result in the stitching due to flattening.

For most print work I recommend saving to PDF/X-1a, Acrobat 4 (PDF 1.3) format and simply ignore the white hairlines. They will absolutely disappear on a commercial press. I've been ignoring similar hairlines for decades for commercial presses.

The problem may be that reproduction has changed in the last couple decades and there are far more online printers using "digital presses" for reproduction. A "digital press" is really just a high-end color copier/printer. It's not that much different than a color printer one may have at their office. If a print provider is not actually using a "press" but rather using a fancy "copier/printer" for production, these lines may still be an issue. Talk to the print provider. They may have tips or tricks which relate to their specific process.

For a sure-fire, no-doubt, absolutely effective, non-wavering, method....

Use PDF/X-4 if feasible

If you're creating a PDF for print production and you just can't bring yourself to ignore these hairlines, you can save as PDF/X-4 rather than PDF/X-1a. PDF/X-4 is not a flat format and the "stitching" isn't necessary for PDF/X-4. This will eliminate the stitching and still provide a press-ready file. However, the PDF/X-4 is a newer PDF version and may require newer equipment (software) on the part of any prepress department. Check with your print provider to endure they will accept a PDF/X-4 file. Although, I've not run into any problematic issues using PDF/X-4 when needed. PDF/X-4 is "newer", but it's not "new". It's been around for over a decade.

Additional for online stuff...

For PDFs which will be distributed online and are not designed for commercial printing, it is best to save the PDF as Acrobat 7 (PDF 1.6) or higher. This eliminates the stitching issue for on-screen display. Again, this is only for PDFs distributed online and not bound for a commercial press.

If you are seeing these hairlines when saving for a web format (jpg, png), you want to be certain to choose Art Optimized as the anti-alias setting in the Save for Web dialog. This will most often correct the issue for those formats. If it does not, you may need to manually flatten areas where the lines are appearing before saving. Or simply select all and use Object > Rasterize then save for web. Or even use Photoshop to open the .ai file and rasterize it. Remember to work on a copy of the file if you need to rasterize it.
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                Hum The only problem with the answer is this: "When I ask for a print proof the outlines show. They don't show when I print it at home." And she is not saying that she is printing from the browser window. Probably that part was edited.
                
                
– Rafael
                

                Apr 3, 2015 at 19:27
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                @Rafael did you miss the bold portion of this answer??? Quote: "These don't show when the art is printed. This is an on-screen issue only."
                
                
– Scott
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                Nop. That was the part I was refering to. I know that is the point of flatten an image. As you use a diferent paragraph Im not sure if you are refering to the PDF X1 or to the original question.
                
                
– Rafael
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                I know that this is a on-screen issue. But she says that "When I ask for a print proof the outlines show."  So I understand she has that line on a printed sample. That is all. :o)
                
                
– Rafael
                

                Apr 3, 2015 at 19:41
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                No. "Print proof" means a PDF proof the print provider sent her. It's not the same things as a proof which has been printed. Probably more about language than anything. Are you a native English speaker?
                
                
– Scott
                

                Apr 3, 2015 at 21:00
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I work in printing / imaging. And NO they don't always disappear at print. What happens is the pre press technician has to do some extra work to guarantee they don't show up. You are better saving in a non X pdf format (High quality print for example). This also doesn't chop your file into tiles and makes it easier for it to be edited @ the prepares level if need be.
In many press applications they disappear/are reduced wth ink flooding but for high quality large format printing, they can show up.
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                I agree with this. I've only had it happen a handful of times, but it does happen that these lines show up. It's annoying, but preventable.
                
                
– GoofyMonkey
                

                Jun 20, 2016 at 20:18
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I've noticed that if you're working with transparencies and save to .pdf, then if you need to optimize your .pdf to reduce the file size (not the 'reduce file size' plugin, but just "Optimize PDF") then you will get bad white lines, and no they don't always disappear when printed.


One trick that I've found that works for me is to 'save as optimized' in two rounds. Open your .pdf, "File->Save As Optimized..." everything EXCEPT Images and Transparencies (keep those unchecked). Then, perform this action a second time "File->Save As Optimized..."this time w/ the images and transparency options turned ON. 


Can't explain why this works and you will still sometimes get the white lines in browser display, but your document should display properly in Acrobat and will print properly. 
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It also  might be a gradient that is hard for you to see that's spilling over outside an image.  I moved those gradients and the little white lines went away.
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I have seen lots of answers and tried all these above, but what worked best for me was this:


	Put all your work,everything in one layer (1Â layer).

	Copy the extruded text and put it on a layer above the rest (2Â layers).

	Export, prepress, no optimizations.
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It starts to make trouble if you use live paint. These lines are the path lines. One way to resolve this is to delete all unnecessary path lines with the help of scissor tool. Yes, this is time consuming and annoying, but it works. Moving some objects to another layer also helps.
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To build on Scott's answer, if you need to make the lines disappear temporarily because they worry your client and that you're unable to export as PDF/X-4 for some reason, adding a layer with a white shape set at "Multiply" before exporting usually removes these lines. Just remember to delete the layer before sending to print.
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This is a problem that also comes up when people export eps from octave / matlab / python matplotlib, and then try to convert to pdf for latex, etc.

As others here have said, it's an issue with aliasing.

What has worked for me is opening the generated .eps file in Gimp, removing text and image aliasing, then overwriting the original.

Stolen from here: https://uk.mathworks.com/matlabcentral/answers/15388-artifacts-in-figures-exported-as-pdf-from-matlab#comment_458029
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                Doesn't "opening the eps with Gimp" rasterize everything? If yes, that's a pretty horrid solution.
                
                
– Scott
                

                Jul 15, 2020 at 21:28
            

        

    
	
        
            
            

        

        
            
                
                @Scott you're absolutely right, thank you for pointing this out! I'll still leave this answer here though in case it helps someone with their particular use-case. I certainly preferred to create a high-res image in my code, and get rid of the lines this way, rather than risk an editor print with the wrong settings and leave it visible. I realise this particular forum may not be the best place for such a 'horrid' solution, but it was the only place on stackexchange I found this issue mentioned, and it may help someone else resolve their problem (as long as they acknowledge this risk!)
                
                
– Tasos Papastylianou
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In Ubuntu, load into Okular, then print to pdf. Then when viewed in Document Viewer there are no white lines.
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        Thanks for contributing an answer to Graphic Design Stack Exchange!
	Please be sure to answer the question. Provide details and share your research!

But avoid â€¦
	Asking for help, clarification, or responding to other answers.
	Making statements based on opinion; back them up with references or personal experience.

To learn more, see our tips on writing great answers.
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